ncsa eclipse internal training

This tutorial will cover the basic setup and use of Eclipse with forge.ncsa.illinois.edu. At the end of the tutorial, you should be comfortable with the
following tasks:

start eclipse and view the forge resource manager for your preferred version of MPI

submit a batch job to forge via eclipse

build code with eclipse and the c/c++ perspective (we'll ignore fortran for this tutorial, but can show you the perspective for it)
use TAU to profile a basic GPU code

use Eclipse to drive TAU performance analysis

Contents.

® eclipse on forge startup, environment, and forge resource manager setup

© add the PTP Contributed Resource Manager Definitions

© open System Monitoring perspective and select the forge mvapich2 definition

o start the forge resource manager locally and impress your friends and neighbors
® CUDA code with eclipse
® TAU profiling with eclipse

© CUDA profiling with TAU is not yet in eclipse, use the command line...

© Paraprof setup on forge

© TAU with mpi compute pi example

eclipse on forge startup, environment, and forge resource manager setup

To start eclipse on forge ?( locally ), add eclipse (and tau) to your $HOME/.modules setup. This is also the place where you'd select an alternate MPI
implementation if you want to stray from the pack and create confusion in this tutorial from the very beginning (openmpi users step forward) . The modules
on forge are displayed with the "module avail" command. The prerequisite for running eclipse on forge is X-windows support and ssh X11 forwarding in
your ssh client (ssh -Y or ssh -X for linux clients ). Now is the time to find a linux or Mac user with X-windows and ssh (working in pairs) if you don't have
that capability on your windows PC:

[arnol dg@orge ~]$ echo "npdul e | oad tau eclipse" >> $HOW . nodul es
[arnol dg@orge ~]$ grep -v '"# .nodul es

nodul e | oad tau eclipse

[arnol dg@orge ~]$ eclipse -Xms512m - Xmx512m - XX: Per nSi ze=256m - XX: MaxPer nSi ze=512m &

When eclipse first starts, it prompts for a workspace location. It's ok to accept the default of SHOME/workspace/ if you don't have a directory with that
name, or you may select an alternate location.
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Workspace Launcher (on forge.ncsa.illinbls.edu)

Select a workspace

Eclipse stores wour projects in a folder called a workspace.
Choose aworkspace folder to use for this session.

Workspace: |iUi{==ErE Ryl

[ Use this as the default and do not ask again

The first time entering a new workspace, eclipse loads a default screen. To get right into eclipse and skip all the tutorials and help (which you'll come back
to next time ? ), select the workbench icon.
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add the PTP Contributed Resource Manager Definitions



First, you'll add the resource managers plugin from http://download.eclipse.org/tools/ptp/updates/indigo_5.0.4 . Copy the URL into your clipboard and then
in eclipse navigate as follows to add the plugin: Help -> Install New Software -> Add (button) , then fill in the boxes with the URL. It should look like this:

L -

Availlable Software

Select a site or enter the location of a site.

W ork with: |type or select a site j [
Find maore softvare by working with the "Available Software Sitg
|type filter text
Mame Yersion

(1@ There is no

alected _
Add Repository (on forge.ncsa.illinois.edu)

Mame: kp:ﬁdownload.ec:Iip5e.orga’toolsfptpfupdatesfindig0_5.0.4 Local..

Location: }p:HdownIoad.ecIipse.UrgftoUIsfptpfupdatesfindigo_S.D.él| Archive..

€ Duplicate location

-\,

@) Cancel | oK

Select All

[etails

Click OK and select the item you want to install.


http://download.eclipse.org/tools/ptp/updates/indigo_5.0.4

Install (on forge.ncsa.illinois.edu) "8 [x]

Available Software

]

Check the items that you wish to install.

Work with: |httpifdownload.eclipse.orgftools/ptp/updates/indigo_5.0.4 - http:ffdownIoad.eclipse.orga’toolsfptj Add...
Find more software by working with the "Available Software Sites” preferences.

|type filter text &
Marme Version =l
= oon FdAlrdneT TUUTE T TAUUTTTT J
O % Parallel Tools Platform (FTF) End-User Runtime 5.0.4.201110200938
[ &4 Parallel Tools Platform SOk 5.0.4.201110200938
[ % PTP Common External Components 5.0.4.201110200838
(1% PTP Common Utilities 5.0.4.201110200838
2 PTP Contributed Resource Manager Definitions 5.0.4.201110200938
£ | 2]
Select All Deselect All 1 itemn selected
Details
Adds resource managers for a number of different systems E
Show only the |atest versions of available software (] Hide items that are already installed
Group items by categary What is already installed?

] Show only softvare applicable to target environment

Contact all update sites during install to find required software

'f?:' < Back | Mext = | Cancel Einish

Press Next, and follow the install prompts, then allow eclipse to restart when finished. If the dialog boxes indicate the software is already installed, you
don't need to restart eclipse.

open System Monitoring perspective and select the forge mvapich2 definition



Under Window -> Open Perspective menu, select the System Monitoring perspective (under Other...) to get started setting up a resource manager to use
with forge. The steps that follow will allow you to monitor the system, queues, and submit jobs to forge all from within eclipse. It's beautiful, colorful,
powerful, and sometimes runs for hours without crashing. You'll like it.

Open Perspective (on forge.ncsam Ell

&' Java B
4 Java Browsing

2! Java Type Hierarchy
WL TTng

£ Parallel Debug

858 Parallel Runtime

() Planning

FiEl Remote CAC++

I8 Remote System Explorer

[~ Resource

stem kAonitoring

¥ BystemTap Dashhoard
& SystemTap Graphing

Cancel ]

Right click in the Resource Managers area background , select "Add Resource Managers", and add the entry for forge mvapich2.



(3 Resource hanagers 2 = O |5 System hMonitor 52

(on forge.ncsa.illinois.edu) ™% @li

Choose Resource Manager Type

Select the type of resource manager to use

Resource hManager Types:

[Bi LoadLeveler

|BM Parallel Environment
MPICHZ

Open kP

Cpen MPI-Generic-Interactive
PBS-Generic-Batch
PB3-Generic-Interactive

£ Active Jobs 32 = |nactive Jobs}

Remote Launch
SLURR

edu.illincis.ncsaforge.phs.batch.mvapichz

edu.illinois.ncsaforge phs.batch.openmpi
edu.utk.nics.keeneland.phs.hatch

edu.utk.nics.kraken.phs batch

@ = Back I Mext = I Cancel Finish

Since we're running locally on forge, leave the Remote Service Provide and Connection Name set to "local”. Accept the defaults for the rest of the forge
resource manager setup. Normally, you'd setup new ssh connections via remote tools here, but by running locally on forge, that's not necessary. There
should now be a forge resource added to the resource managers view.

System Monitoring - Eclipse (on forge.ncsa.illinois.edu) "™l

File Edit Mavigate ZSearch Project Bun MWindow Help

start the forge resource manager locally and impress your friends and neighbors

Right click on the forge.pbs.batch.mvapich2 resource and start it. It should go from grey to green and bring up a display like:



System Monitoring - Eclipse (on forge.ncsa.illinois.edu) ™™ Eﬂﬂ

File Edit Mawigate Search Projest Run Mindow Help
jrra @@ s 0rar e o = [system M.,

(=) Resource Managers &3 iii system: forge.ncsaillinois.edu &8 =0

edu.illinois.ncsaforgephs.batch.n

22 Active Jobs 22 = |nactive mes}

step | owne| gueu| wall| gueu | dispe| totalc| status

3230 cheal normil3200 | 20711+ 2011+ 16 | RUNNING
3231 cheal normil3200 | 20711 2011+ 16 | RUNNING
3232 cheal normil3200 | 20711+ 2011+ 16 | RUNNING
3233i cheal normil3200 | 20711+ 2011+ 16 | RUNNING
3234 cheal normil3200 | 20711+ 2011+ 16 | RUNNING
3235 cheal normil3200 | 20711 2011+ 16 | RUNNING
3236 cheal normit3200; 20114 20114 16| RUNNING
3237 cheal normit3200; 20114 20114 16 RUNNING
3238 cheal normit3200; 20114 20114 16 RUNNING
3z40; alberl, normi}3200 ; 20114 20114 18 RUNNING
3z24z; alberl normi}3200; 20114 20114 18 RUNNING
3244, kshee normi 4400 20114 20114 B4 RUNNING
3Z45; cheal normit3200; 20114 20114 16 RUNNING
3246 cheal normit3200; 20114 20114 16 RUNNING
3247 cheal normit3200; 20114 20114 16 RUNNING
3248 cheal normit3200; 20114 20114 16 RUNNING
3248, cheal normit3200; 20114 20114 16 RUNNING
3250: cheal norm:33200: 2011+ 2011+ 16 RUNNING

E NI DD EEEEEEOENEEDODEO

& Console &2 B Pruperties] B Prub\ems] ¥ Tasks]
Mo consoles to display at this time. ] [ =t Elv [

You can begin exploring the wonderful world of eclipse resource managers from here. Use the Run Configurations under the Run menu if you have an
application or job script ready to run on forge.

[[long@orge ~]$ qsub -1 -1 nodes=2: ppn=4, f| ags=ADVRES: ecl i pse  # sanpl e gsub command |ine show ng access
to the tutorial reservation

CUDA code with eclipse

Import the code below into a new c++ project (rt click in the open area under c/c++ perspective's Project Explorer pane. Name your project and select the
Makefile and Empty Project for it's type, then when the project appears in the pane right click on your project and : Import->General->Filesystem) and bring
in the vecadd/ code from your $HOME. Then follow the steps in the 2nd bullet link (or attached PDF) below.

cp -R ~arnol dg/vecadd/ $HOME ; |s $HOME/ vecadd/

® cdt and cuda makefile projects
® build the project with eclipse ( Project -> Build , or use the hammer icon )

TAU profiling with eclipse

CUDA profiling with TAU is not yet in eclipse, use the command line...
This URL describes using TAU with cuda code:

http://www.ncsa.illinois.edu/UserInfo/Resources/Software/Tools/TAU/#gpusupport


https://wiki.ncsa.illinois.edu/display/WHPC/cdt+and+cuda+makefile+projects
http://www.ncsa.illinois.edu/UserInfo/Resources/Software/Tools/TAU/#gpusupport

$ cd $HOVE/ vecadd

$ tau_exec -T serial -XrunTAU-cupti-icpc -cuda ./vectorAdd

$ # press return to exit the vectorAdd program

$ paraprof &

$ | ess /usr/apps/tool s/tau/ READVE. gpu # experinment with TAU METRICS set in your environment

T TAU: ParaProf: node 0 - /uf/ncsa/arnoldg/vecadd/MULTI__CUDA.Tesla_M2[-](0][x]
File Options Windows Help

Metric; CUDA Tesla_mM 2070 domain_a.inst_issued
YWalue: Exclusive
Jnits: counts

dBgees L] TA application
1 EES O | CuclaCetLastError
126012 ] cudaMemcpy
E0255 el CUClalaunch
9 | cudaSetupArgument
4 | cudamalloc
0 | cudaConfigureCall
0 | cudaSetDevice
0 | cudaFree
0 | cudaThreadExit

File Options Windows Help

Metric; CUDA Tesla_M2 070, domain_a. active_oviles
YWalue: Exclusive
Inits: counts

dbEEsd b | TA application
Lo T Y cudaMermicpy

139300 oo | cudaGetLastError
10761 [ cudalaunch

1.4E-30% | cudaSetupdrgument
I BE-Z16 | cudamalloc
1.9E-216 | cudaSetDevice
1.9E-%16 | cudaconfigurecall
O | cudaFree
0 | cudaThreadExit

Note for the bored: the dev/ directory contains triall.cvp created by computeprof--the Nvidia-CUDA profiler that ships with CUDA. You can visualize it with
the computeprof command on forge.

Paraprof setup on forge
® start paraprof from the ssh command line (not in Eclipse )
© File -> Database Configuration -> accept defaults , confirm new perfdmf database/schema and "Save Configuration"

® Exit paraprof (important because there can not be 2 paraprof processes trying to access your database at the same time...Eclipse will be starting
one in the steps that follow)

TAU with mpi compute pi example

A requirement for using TAU with eclipse locally is to setup the following directory and symbolic link to work around an Eclipse bug with TAU:



$ cd $HOVE

$ nkdir -p ./uf/ncsa

$ In -s $HOME ./ uf/ncsal/ $USER

pat hnane

# wor karound to handl e Eclipse/ TAU trying to submit jobs with $HOVE/ $HOVE in

Create a new project in eclipse by right clicking in the Project Explorer pane of the c/c++ perspective and choosing the MPI PI C example project with the
gcc toolchain. This should create a new project with source files in the src/ directory.

The project will probably need the mpi.h include directory defined and added to all languages/configurations. Build the application when you're done with
this step. A Debug/ directory should appear in your project which we'll need later when filling out the Profile Configurations -> Application tab:

=
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|type filter text

b Resource
Builders

b C/C++ Build

b C/C++ General
Discovery Options
Environment

Project References
RuniCebug Settings
Service Configurations
Settings

b Task Repository
Task Tags
Tool Chain Editor

b Validation
Yariables
WikiText

[« [ »]

Properties for mpipic (on forge.ncsa.illinois.edu)

Paths and Symbols

Configuration:

Debug [ Active ]

low whw

- ‘ hanage Configurations...

4

= ncludes | # Symbols |5.,Libraries |@Libramr Paths IBSource Locati0n| el Referencesl

Languages

Assembl

Show buil

“"Add directory/ path' (on forge:ncsa.illinois.edu)|x)

Directory:

| fusrflocalimpifmyvapich2/mvapichz-1.7rc 1-intel- 12.0.4/nclude]

[ Add to all configurations “ariahles...

Add to all |
U = Workspace..

[ = Is aworkspace path

il

File system..

Cancel

o]

| Add..

t-in values

&% Import Settings.. | %% Export Settings... ‘

Edit...
[elete

Export

Ivlowe Up

IMove Down

R

Restore Defaults | Apply

To profile with TAU, there are a couple steps to follow in the c/c++ perspective. First fill out the TAU settings under the TAU tab for the Profile
Configurations. For the first TAU trial use the default settings.




= ProfilerConfigurations (on‘forge ncsalillinoisiedu) 23]
Create, manage, and run configurations ff‘?'lx\
Build C, C++ or Fortran applications with performance analysis tools. Launch parallel programs from within k__llj
Eclipse via the PTP. —
T B % B B MName: |mpipic
‘type filter text & ||| P8 Enviranment [Performance Analysis |Parametric Study |2 Common [ £ TAL . 3
[+ IFT ] WENEFarE WET NCIUHE 5T B

. o
(] &t + Application | ¢ abath Profiing

< &% Parallel Application (] Phase Based Profiling
: g4 O] iemory Profiling

o
o

@ Profile With QProfile | | ©PAR]
B Profile With OProfile ( | | GpenhiP
4 Profile With valgring | | [ Epilog
(] YampirTrace

B Launch Group

] PAPI Select PAP| Counters | @ Preset Counters O Mafive Counters

] Perflib

] Trace

] PDT ) POT Instrumentation & Compiler Instrumentation

Select hakefile: hakefile tau-icpe-mpi v| =

| |
( 2

Appl Revert

Filter matched 7 of 8 items PRYY | Eye ‘

/'5 Close ‘ Profile |

Set the Performance Analysis tab to build-only without launch, then Apply and Profile the application which will build a new TAU instrumented version of
the code.

]

- Profile"Configurations™ (on"forgeincsatillinoisiedu)
Create, manage, and run configurations Py
Build C, C++ or Fortran applications with performance analysis tools. Launch parallel programs from within Q/‘)
Eclipse via the FTP. T
iE X | B & Marne: ‘mpipic
|type filter text & | [e= Arguments | B8 Environment (Performance Analysis - Parametric Study| = TAU| 3
€] C/C++ Application Toal Selection |
¥ Launch Group Select Tool: Tal v
= 853 Parallel Application

- Add Workflow ®kAL File | Femove Warkflow =hiL File

B Profile With OProfile Build the instrumented executable but do not launch it

B Profile With OProfile { || |0 Select existing performance data to analyze with the selected tool
& Profile With walgrind

While building, watch the console in eclipse for the TAU compile and link commands. These can be useful later if you run TAU outside of Eclipse (or in
your larger Makefile to define the compiler and linker commands ):



***%* Build of configuration Debug__tau-icpc-npi for project npipic ****

neke all

Building file: ../src/npipic.c

I nvoki ng: GCC C Conpi | er

/usr/apps/tool s/tau/2.20.3-forge/ x86_64/bin/tau_cc.sh -tau_options='-optConplnst ' -tau_makefile=/usr/apps

/tool s/tau/2.20.3-forge/ x86_64/1ib/ Makefile.tau-icpc-nmpi -I1/usr/local/npi/nvapi ch2/ nvapich2-1.7rcl-intel-12.0.4

/include - -g3 -Wall -c -fmessage-length=0 - MWD - MP - M-"src/ npipic.d" -M™src/ npipic.d" -o "src/npipic.o"
/src/mpipic.c"

Fi ni shed building: ../src/npipic.c

Bui I ding target: npipic

I nvoki ng: GCC C Linker

[ usr/apps/tool s/tau/2.20. 3-forge/ x86_64/bin/tau_cc.sh -tau_options='-optConplnst ' -tau_makefile=/usr/apps
/tool s/tau/ 2.20. 3-forge/ x86_64/11ib/ Makefile.tau-icpc-mpi -0 "nmpipic" ./src/npipic.o

Fi ni shed building target: npipic

*¥*%* Build Finished ****

Building will create a new directory named similar to the TAU makefile from the TAU tab options. Once the instrumented application is built, then fill out

the Profile Configuration tabs for the Application and Arguments to point to that executable and directory:

_./’l 1 ||E| arnoldg | eclipse_tmp | mpipic |Debug tau-icpc-mpi

Blaces Mame ¥ | Size odified
, Search = sre 1316
ecent se makefile 1.1 1316
@R by Used | ) makefi KB
[ arnoldg I mpipic
[ File System | | objects.mk 731 bytes 1316
SOUrces.m 392 bytes 1316
[ k ]

The Arguments tab should be adjusted to point to that directory (deselect the default directory box and browse the path ).

1 mpipic 3.2 WB 1316
"t ohjects.mk 231 bytes 1316
4 sources.mk 397 bytes 1316

[= arnaoldg
[F] File System

:’l 4 ||'i‘~ arnoldg | eclipse_tmp | mpipic [|Debug__tau-icpc-mpi Create Folder
Places Mame ¥ | Size hodified | —
7, Search [ sre 1316
& Recently Used | 1 makeflle 1.1 KB 1316




Then in the Performance Analysis tab, allow TAU to profile for this run by deselecting the build-only box:

Create. manage, and run configurations @

Build C, C++ or Fortran applications with performance analysis tools. Launch parallel programs fram within
Eclipse via the FTP, =T

RERR [ 0 3o~ Mame: |mpipic:
Itype filter text ) Application &= Arguments | Environment Performance Analysis T TAU| ™

b [E] C/C++ Application Tool SE|ECti°”|
B Launch Group Select Tool: TAL ["l
~ 5 Parallel Application [, 4 yioridow XL File | Remave Workflow XML Fie |

@ Profile With OProfile ] Build the instrumented executable but do not launch it

I Profile With OProfile ( ||| Select existing performance data to analyze with the selected tool
& Profile With Valgrind

You will need to fill out the Resources tab to describe the job you want to run. Select a queue (debug), Number of Nodes (1:ppn=4,flags=ADVRES:
eclipse) , Mpirun command (mpirun_rsh), Number of cores (should be nodes*ppn or 4), and wall time (ten minutes = 00:10:00 ).
Finally, once the program runs, use TAU. Allow TAU to run in the background if the dialog box persists while the job is submitted.

rﬂ_TNIEI‘E'ParaP‘r_Df':nod'é's-_A‘ﬁﬁli'E'ifion0,‘Experiment 0] 5 == IMIEE]
File Options Windows Help
Metric: TIME
value: Exclusive L J O~ 2] I%Cfc++ »
Units: seconds
eriment 0, Trial 0. NE=E —
0553 | cale_pi [{fuffnesafarnoldg/eclipse_tmpfmpipic/Debug =]
0106 [ MPI_Initd —
0.035 & .TAU application =
0.005 | MPI_Finalize( —
4.7E-4 | main [{juf/ncsa/arnalda/eclipse_tmp/mpipic/Debug__
2.3E-4 | MPI_Bcast)
1.2E-4 | MPI_Sendp
2.7E-5 | MPI_Reduce(
1.0E-6 | MPI_Comm_rank( ,
1.0E-6 | MPI_Comm_sizeq) id
int
[— r
(] I | I» 2 |
il I-‘rotﬂ?mspg, |asKs|L=4 _onsole [ Froperies | iz Kemote Enwiro (I} Performance DaProgress} =0
Using Database: Default Launch ParaProf[ 0 @ w T
¥ (= mpipic
= [= icpc-mpi
o] [ 2]
| =

Homework questions.
How could you use Eclipse with TAU and a Makefile project ?

Can you manipulate jobs (cancel ) in the Systems Monitoring perspective ?



Does the Systems Monitoring perspective support more than one running resource manager ?



	ncsa eclipse internal training

